Using CMS

Overview

A web content management system (CMS) is software used to manage and control large scale websites. It allows users to organize, enter and publish correct and relevant information to a web page in a timely manner, with no formal web training required.

Advantages of CMS

- Control of online content to achieve accurate information
  - Easy editing (WYSIWYG)
  - Scalable feature sets (plugins/modules)
  - Document lifecycle management (versioning, archive)

- Accomplishing a consistent look and feel for your website, that also fits into the design of the larger ETSU web
  - Balance individual look and feel with overall consistency as part of ETSU web
  - http://www.etsu.edu/cas/arts
  - http://www.etsu.edu/admissions
  - http://www.etsu.edu/finaid

- Implementing a site that adheres to accessibility and usability standards
Objectives of the Workshop

- Gain familiarity with the basic “look” of CMS
- Learn how to upload documents and pictures
- Understand how to edit webpages
- Learn about creating links and inserting pictures
- Understand the use of tables in webpages
1 Login to the CMS Server

To login to the CMS Server go to:

http://etsubplst.etsu.edu/lcms/component/main

Enter your ETSU username in the field that says “Login Name” in ALL UPPERCASE LETTERS. Enter your ETSU password in the “password” field below in whatever mixture of upper and lower case characters you normally use.

If you don’t use all uppercase characters for your Login Name, the system will not allow you to login to the server.

Another URL you should bookmark: http://www.etsu.edu/cms

This will take you to the main site for information about the CMS system, including FAQ’s, contact information, and system status.
2 Exploring Your CMS Site

When you login to CMS, you’ll see the name of your department’s website on a page that says “My Workgroups”.

![CMS My Workgroups Image]

If you have access to more than one “workgroup” (same as website), you should see all of them on this page. Most people will see only one.

You can now enter your website by just clicking on it. You will see a view that looks something like the following:

![CMS WebViews Image]

Depending on how large and complex your website is, you may see many of these objects called “webviews”. If your website is not very complex, you may see only a few, or perhaps only one. Every website will have at least one webview, named “Home”. What is a webview? It's simply a container, or folder, for holding the webpages that make up your website. Your task now is to determine how your webpages are organized into these webviews.
First, note that a URL is given under the webview named Home. In the example above, the URL says "/com/compliance" (we’re using the College of Medicine’s Compliance Office as an example). This is the URL that people will follow to the Compliance website once it’s completed and live (with www.etsu.edu in front of it, of course).

You can use this URL now to look at your website. If you’ve just started to work on your website, it’s just a “shell”, but it still exists.

If you’re unfamiliar with the way CMS organizes your webpages into webviews, it’s a good idea to examine your website at the same time you are in CMS. With Internet Explorer 7, you can just open another tab. If you have IE 6, you can open a second session of Internet Explorer. This is how the ETSU College of Medicine Compliance Office website appears with a browser:

Notice that there are 5 items on the left navigation. Each of these items is either a webpage or a webview. The item is a webpage if it does not have any sublinks. It’s a webview if it does have sublinks, and each of the sublinks represents a separate webpage contained within the parent webview.

In this example, only one of the items in the left navigation, ETSU Compliance Plan, appears to have sublinks. So it’s a webview, and all the other items in the left navigation are webpages.

Home, Staff, Compliance Topics, and HIPAA are webpages and they’re contained in the webview named “Home” (don’t confuse this with the “Home” webpage). Every website has a webview named Home, and it always contains the items (which are actually webpages) in the left navigation that have no sublinks. In addition to the Home webview, this website has another webview named “ETSU Compliance Plan”, which contains the 3 pages that correspond to the sublinks.
Here are the two webviews again that compose this website:

![ETSU Compliance Plan](image1)

When we open the ETSU Compliance Plan webview, we find:

![Files](image2)

Complaint, complianceplan, and receipt are the 3 webpages that correspond to the sublinks we saw in the left navigation. Notice that there’s a fourth webpage named “default”. This webpage just contains links to the 3 other pages, and is opened in case someone clicks on “ETSU Compliance Plan”, instead of following the sublinks. More on links later.
When we open the Home webview, we find these webpages:

<table>
<thead>
<tr>
<th>Files</th>
</tr>
</thead>
<tbody>
<tr>
<td>contactus</td>
</tr>
<tr>
<td>mypage</td>
</tr>
<tr>
<td>topics</td>
</tr>
</tbody>
</table>

The page named “default” is the website’s home page. The pages named “contactus”, “hipaa”, “staff”, and “topics” correspond to the left navigation links.

If you ever need to change your website’s left navigation, contact the CMS web team.

Note that CMS will typically show you 10 items at a time.

If you have more than 10 pages in a webview, or more than 10 webviews, just look for the above information on the display and change it to a larger number, if desired.
3 Importing Documents and Pictures

Before you start modifying your webpages, it’s a good idea to import some “building blocks” into your website that you’ll use: namely, documents and pictures. Before using any documents or images in your website, they must be imported into your website. In the Home webview, you should see a list of folders, as shown below:

The only folders that you’ll use are Documents and Pictures, and these folders are only found in the Home webview. The other folders contain system files that the campus web designers have used to create your website. Do not modify the files in any of the other folders, as this will damage your website.

For documents, consider using only PDF files. They load faster than Word documents, and PDF files don’t require visitors to your website to have Word installed on their computers. There are several different formats for images, but the only types allowed in the system are GIF, JPG or PNG. Do not use BMP files in your web page, they are too large and will make your website unusable to visitors. If you have questions about types or sizes of images, please contact our web developer (Tanner Clements).

GIF, JPEG and PNG images are relatively small in size and have good resolution. Our experience has shown that image files that are less than 400Kb and a resolution of 72 seem to work best. If the file is much larger than that, it may cause the webpage to load very slowly, which causes an unpleasant viewing experience for your visitor.

To import a document, click the Documents folder. You’ll see a window that looks like the following:

This Documents folder already has 6 documents in it. To add a new one, just click Import, the rightmost link at the top of the page where it says “Folder Actions.”
When you click on the Add Files button, it’ll open a Select Files window. Navigate to the file or files that you wish to import and click on the file, then OK:

When you click the Next and Finish buttons, CMS will import the document into your Documents folder.

Here’s the document in our Documents folder. The final step before using the document is to click on the Submit button. This has to be done for every document and image that you import, in order to make the file ready for use in your webpages.
When you click on the Submit link, you’ll see the window below. Just click on the Submit button on the lower right-hand corner of the page once more, and the process is finished.

Note that now the Submit link next to the document in your Documents folder is “grayed out”. This is how it should appear for all your documents and pictures.
If you should ever need to delete a document or picture, first click on the More link on the far right that corresponds to the file you wish to delete.

This will bring up a submenu; click File > Delete. When you do, CMS will warn you that there is no way to undelete a file.

Once you've finished importing documents or pictures, to return to the Home webpage, just click on the link that says “Home”. It's near the top of the page.

Pictures are imported in exactly the same way. Just remember to open the Pictures folder in order to import your images. Also remember the recommended size limitation, 400 Kb and a resolution of 72.

4 Working with Webpages

In all of your webviews, you'll see the webpages arranged as shown below, with several links to the right of each webpage:
Click on the View link just to view, not edit, your webpage. You’ll click on the Edit link to make changes to your webpages. After editing a page, if you’re satisfied with your work, you’ll click on the Submit link to publish your changes to the web server.

The Checkout link is used to “reserve” a page that you’re working on (like checking out a library book) so that someone else in your workgroup wouldn’t be able to overwrite your changes. This is used if you’re interrupted while using CMS. Since CMS is designed to be multi-user, any page that you’re working on will not be available to anyone else until you finish. When you finish with your changes, to make the webpage again available to others in your workgroup, click Cancel Checkout.

Just like when you’re working with documents and images, if you should ever need to delete a webpage, use the More link. Remember, though, that just like with documents and images, there is no “undelete”!

5 Creating a New Page

It’s often a good idea to create a “test page” as you’re familiarizing yourself with CMS, so you can feel comfortable experimenting with the editor and not worry about making mistakes on one of your website’s “real” pages. And the nice thing about a “test page” is that you can keep it in your website as long as you want, with no concern that it’ll be “visible to the world”. As long as it has no link to it, like your “real” webpages do, it’s invisible.

Here’s how to create a new webpage: first, click on the New Document link, near the top of the page in the Folder Actions area.

In the next window, type the name of your new page. You should use only lowercase characters, and no spaces between words.
That’s all the information that is needed at this point. Click the Next button. Now you’re presented with several different “layouts” for your page. Choose the one that says page_layout_1024_(webviewname)”, then click Finish & Edit at the bottom; that will take you into the editor.

When you click on the edit button you will open the editor. There are three items that you will see the Dept Banner Zone – marked in gold, the Center Column Information Zone marked in red, and the Right Column Information Zone marked in blue. When clicking on the grey box marked edit this zone it will open either the center column or the right column depending on which box you click. This will give you access to add content to the columns. The deptbanner zone is where you will add your department banner. To view the department banner on each of your webpages you will need to add it to each page. The banner will be located in your picture folder in your home webview. To import the banner follow the directs on importing a document on pages 18 and 19 of this handout.
In the editor, you’ll now see a blank webpage below some familiar-looking edit buttons.

Above the page, notice there are 3 blank areas; these are called Page Title Zone, BreadCrumb Title Zone, and Document Title Zone.
It’s not that important at this point what information you enter into these fields because we’re just creating an “experimental” page, but when you create a real page, these fields are important. Here’s how they will appear once the page is live:

The top arrow shows where the information in the “Page Title Zone” will appear. The middle arrow points to the “BreadCrumb Title Zone” information, and the bottom arrow shows the “Document Title Zone”. Note that all three of these titles are exactly alike. In most cases, that’s what you should do in order to make the information uniform. Use upper and lower case letters and spaces here to make the information more readable.
6 Using the CMS Editor

The editor and a blank page appear below. Notice it looks very similar to a word processor. There are buttons for bolding, underlining, justification, color, font style, and more. The editor also has a real-time spell checker, which is handy.

Just like a word processing editor, you can use the backspace or delete keys to correct mistakes. If you need to make changes to text that you’ve already typed, just right-click it and choose the appropriate command (see below).
Most people are interested in moving text into their new pages quickly. You can easily do a Copy and Paste operation if you have text in another document that you need to move into your new webpages.

Just select the text in your old document, and Edit>Copy, then click on the desired location in your new webpage, and do Edit>Paste.

Note that there are several “paste” options available. You’ll need to use the “Paste Plain Text” option as this option strips out all formatting codes and just leave text. You will at this time have to reformat your text.

Often you’ll find a need to use a bulleted list in one of your webpages. If you decide to use a bulleted list, you should **always** use one of the bullet buttons on the editor toolbar. To start, just click on one of the bullet buttons.

Type in your first item, then press Shift-Enter to get another bullet.

To enter additional information under a bullet, just press Enter without the Shift.
Creating Links

It’s important to have a good understanding of how to create links on your webpages. This is a very powerful concept, and you’ll use it often. Fortunately, CMS makes this process very easy. First you should understand that you can create a link to several different things: to documents, to external URL’s, email, to other pages within your website, and even to pictures.

To create a link, first type in some explanatory text. For example, you might type: “click here for the current schedule of events”. Now select the text, then click on the create link button:

You’ll now see the Insert Link window, which has a list of folders on the left, a list of “files” (webpages in this case) that are in the current webview on the right, and a URL window where you can type in an external URL:
We want to link to a document in the Documents folder named “schedule”, so we double-click on Documents under “Folders”. Now we should see the contents of the Documents folder:

Next, we want to click on “schedule.pdf”, and click the OK button at the bottom. That's all there is to it. The ‘power’ of using links like this is that, if you need to keep a current schedule of events calendar in your website, all you need to do is to have a link! You don’t have to modify your webpage at all. You do, however, need to remember to keep the current “schedule document” uploaded to your Documents folder after you delete the old one.

Remember that the Documents folder is only in your Home webview. If you’re working on a webpage that is not in your Home webview, and click on the Insert Hyperlink button, you won’t see the Documents folder, you’ll only see this:
All you need to do is to double-click on the ellipsis. The first time you double-click on it, you’ll see the names of all the webviews in your website; just double-click again on Home, and you’ll now see the Documents folder.

Inserting Pictures

CMS has also made inserting pictures easy, but there are a couple of things to keep in mind when working with images. First, you’ll probably want to insert images into a table. This allows you to better control exactly where the picture appears on your page. It is possible to insert an image directly onto a page, but then you can only use the justification buttons to control its position. “Dragging” an image isn’t possible.

To create a table, simply click on the Insert Table button in the toolbar, specify the number of rows and columns you want, then click the OK button:

We specified 2 rows and 2 columns, and here’s the result. Now we want to insert an image into the top left cell on the table, so we position the cursor in that cell, and click on the Insert Image button.
In the Image Dialog window, we want to double-click on the Pictures folder, because that’s where all of our images are.

Let’s say we want to insert the picture named Home1.
Notice it has a predefined width and height (in pixels), but if we need to change the size of the picture on the page, we can change that here. We can also resize the picture once it’s on the page if we need to. It’s very important to note the field that says “Alt text” in this window. This is the field that will be “translated” to visually-impaired visitors to your website, and you must enter some information here about what the pictures represents, by law.

Now just click the Insert button to insert the picture into your table. Here’s the result:

By clicking on the image to select it, then clicking on the “handles” indicated by the arrows above, you can size the image however you like. Always grab the side “handles” when resizing images to keep the image in the proper proportion.
Once you “click away” from the image to de-select it, you can drag the cell “frames” closer or further away from the image.

Notice that the cell in your table has automatically expanded to fit the picture. Now that you have an image in the left cell, you can begin typing descriptive text in the right cell. Unless you know how to use HTML coding, this is the only way you can have text beside an image on your webpages.

By default, the text that you type will begin in the middle of the cell and move upward as you type. You can control this with the following commands:

First, right-click in the cell where you’re going to enter text, then click on Cell Properties.
Then change “vertical alignment” to whatever you want:

There are many things that you can do with tables, including making the table borders invisible, so that it doesn’t appear that your webpage is using a table at all. Here’s how to do that:

Right-click on any cell, and choose Table Properties

Now change Border Width to zero, using the ↓(down arrow)
7 Saving and Submitting

Once you’ve finished an editing session, click on the Save button on the top left of the page to save your work.

You’re now presented with a view of your saved page. You can click on Edit to make additional changes, or click on Submit. It’s a good idea, even before your website is live, to get into the habit of clicking on the Submit button once you’ve made changes to a webpage. Once your website does become live, the changes you make will not be visible to “the world” until you click on the Submit button.

When you click on the Submit button, you’ll be presented with a window that looks like this:

Just click on the Submit button in the lower right-hand corner once more.

At this point, you can re-enter the editor by clicking on the Edit button, or click on the Site Studio link to look at more pages in your website, or click on the Logout link to quit.